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Section 1: Introduction 

1.1 How to Use This Manual 
This manual explains the setup and configuration of the VIP 4500 series using the Venus® 
7000 software, V-Tour®, and Tera Term®. Specifically covered are instructions on first-time 
setup and use as well as initial power-up procedures. For a complete command reference that 
describes all configuration options refer to Section 10: Command Reference.  

Important Safeguards 
• Read and understand these instructions before installing. 

• Do not drop the VIP 4500 processor or allow it to get wet. 

• An ambient temperature range of -20°C (-4°F) to 40°C (104°F) is recommended. 

• Disconnect power to the VIP 4500 processor when not in use. 

This manual is divided into ten sections: 

1. Introduction covers the basic information needed to use this manual. Take time to read 
the entire introduction as it defines terms and explains concepts used throughout  
the manual. 

2. System Logic Flow and Input Options provides general information on how VIP 4500s 
typically integrate into a control room setting and which options are available for inputs. 

3. VIP 4500 Configuration Using Venus 7000® Software provides general information on 
how to control the VIP 4500 using the Venus 7000 Shell program. 

4. VIP 4500 Configuration Using Tera Term® provides general information on how to 
configure the VIP 4500 using Tera Term®. 

5. VIP 4500 Configuration Using V-Tour® provides general information on how to 
configure the VIP 4500 using V-Tour®. 

6. Advanced Operation provides a user with the tools to optimize or troubleshoot the  
VIP 4500. 

7. VIP 4510 Converter provides general information on how to configure the VIP 4510 
converter using the Venus V7 VLink Debugger or Tera Term®. 

8. Front Panel Instructions provides general information on how to change the VIP 4500 
settings through the Front Panel Interface and also includes a list of the settings that can 
be changed.  
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9. Web Page Navigation provides general information on how to access and use the  
web pages. 

10. Command Reference gives a detailed explanation of each command and its function. 

Daktronics identifies manuals by an ED or DD number located on the cover page of each 
manual. Other manuals referred to in this manual are identified by their ED or DD numbers. 
For example, this manual would be referred to as ED-16594. 

1.2 Common Acronyms 

Acronym Meaning 

HD-SDI High Definition Serial Digital Interface 

SDI Serial Digital Interface 

VGA Video Graphics Array 

SVGA Super Video Graphics Array 

XGA Extended Graphics Array  

SXGA Super Extended Graphics Array 

RGB Red Green Blue (color model based on additive color primaries) 

DVI Digital Visual Interface 

NTSC National Television System Committee (television format) 

PAL Phase Alternation Line (television format) 

SECAM Séquentiel Couleur Avec Mémoire (French télévision format) 

DDR Digital Disk Recorder 

VTR Video Tape Recorder 

WFM Wave Form Monitor 

IRE Institute of Radio Engineers 

http://encyclopedia.thefreedictionary.com/S%c3%a9quentiel+Couleur+Avec+M%c3%a9moire
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1.3 Conventions Used in this Manual 

Bold Any item that requires direct action, such as clicking, pressing, selecting, or 
formatting, appears in boldface. Any item within the manual to reference, 
such as a figure or another section, also appears in boldface. 

Italics Indicates an item visible on the screen or within a menu. No direct action will 
be taken on this item. Captions also appear in italics. 

[X] Represents a keyboard key that needs to be pressed. 

“Quotes” Items that need to be typed. 

Click Press and release the left mouse button. 

Double-click Press and release the left mouse button twice. 

Right-click Press and release the right mouse button. 

> Followed by (ex. File > Open). 

1.4 Product Overview 
The VIP 4500 serves as an interface between a video source and video display. The VIP 4500 
has 10-bit digital processing that allows for 4.4 trillion colors, depending on the display type. 
It accepts standard NTSC, PAL, and SECAM video formats, as well as high-definition digital 
formats. It accepts the following inputs: analog composite, analog component, HD 
component (up to 720p), HD-SDI (up to 1080i), S-Video, SD-SDI, VGA, SVGA, XGA, WXGA 
and SXGA, in RGB or DVI. Refer to Figure 2 in Section 2.2 for an illustration of the processor 

The VIP’s Active InputSM architecture provides aspect ratio versatility, allowing a wide range 
of video sources to be display on video boards with traditional or non-traditional aspect 
ratios. Active InputSM architecture also makes it possible to accept multiple live inputs and 
incorporate zoning, alpha blending, keying, and seamless switching effects into a  
video presentation.  

The VIP 4500 optimizes video signals for correct appearance on LED video displays. The 
processor uses True PixelSM processing to reduce errors and noise inherent in video signals. 
Features of True PixelSM processing include color space conversion, adjustable gamma 
correction, motion processing, and 3-D noise reduction. 
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Section 2: System Logic Flow and Input Options 

2.1 VIP 4500 System Logic Flow  
The VIP 4500 accepts both digital and analog video sources as well as content from the DMP.  
DMP content is sent using Daktronics’ proprietary VMax4TM signal. DMP content consists of 
real-time data, animations, AVIs, schedules, and sequences.  

After the VIP 4500 processes the incoming video signals, it sends a VMax4TM signal to an A/B 
switch. Primary system is routed to port A while the backup system is routed to port B. If the 
primary system goes down the user simply uses the A/B switch to start sending data from 
the backup system. 

Figure 1 illustrates one of numerous ways to configure a control system. Please contact a 
Daktronics project manager for specific information on a system. 

2.2 VIP 4500 Processor Input and Output Options 
Each processor is capable of simultaneously displaying four total video sources in addition to 
one VMax4TM signal. The sources can be composed of a variety of video standards. 

 

Figure 1: VIP 4500 System Logic Flow 
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Up to four SD-SDI or HD-SDI sources can be displayed at one time. These sources may come 
from a variety of digital output devices, including cameras, decks, switchers, and DDRs. A 
BNC connection located on the rear of the VIP accepts the feeds. Refer to Figure 3. The loop 
out connectors, located to the right of the HD-SDI/SDI inputs, can send the same source to a 
backup VIP 4500 video processor.  

 A maximum of four analog video sources can be connected at one time. The VIP 4500 
processor accepts component, S-Video, and/or composite sources. Refer to Figure 2 and the 
following table for more information.  

 

 

Figure 2: VIP-4500 Video Processor (Front and Rear) 

 

Figure 3: Four SD-SDI/HD-SDI Ports 

 

Figure 4: DVI/VGA Ports 

 

Figure 5: VMax4 Input/Output 

Source Type Required Connections  

Composite signals 1 BNC cable  

S-Video 2 BNC cables 

Component Signals 3 BNC cables 
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Two DVI (Digital Visual Interface) or VGA (Video Graphics Array) sources may be connected 
at one time. These sources come from a variety of devices, such as desktop computers, 
laptops, or content servers. Figure 4 depicts both the DVI and VGA inputs.  

The processor accepts VMax4TM signals transmitted over coax or fiber-optic cable. Only one 
input can be active at a time. VMax4TM may come from a DMP 7000, another VIP 4500 
processor, or VIP 4510. Refer to Figure 5.  

A total of three processors may be linked together, allowing up to 12 different video sources 
to display. In this setup, the VMax4TM

 out from one VIP is routed to the VMax4TM on the 
second processor. This is repeated until all three processors are linked to obtain the 
maximum number of inputs.  

2.3 EDID Supported Resolutions Table 

VGA Resolution 
(Height x Width) VGA Frame Rate DVI Resolution 

(Height x Width) DVI Frame Rate 

480 x 640 60 480 x 640 60 

480 x 640 75 480 x 640 72 

600 x 800 56 480 x 640 75 

600 x 800 60 600 x 800 56 

600 x 800 72 600 x 800 60 

600 x 800 75 600 x 800 72 

768 x 1024 60 600 x 800 75 

768 x 1024 70 768 x 1024 60 

768 x 1024 75 768 x 1024 70 

1024 x 1280 60 768 x 1024 75 

864 x 1152 75 1024 x 1280 60 

720 x 1280  60 864 x 1152 75 

960 x 1280 60 720 x 1280  60 

  960 x 1280 60 

  900 x 1440 60 
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Section 3: VIP 4500 Configuration Using Venus® 
7000 Software  

The V7 VLink Controller in the Venus® 7000 software program allows the operator to control 
multiple VIP 4500s. Each processor can output up to four video sources simultaneously. This section 
focuses on setting up, adjusting, and operating multiple processors and their inputs using the Venus® 
7000 software. Refer to the DMP-7000 Installation and Setup Manual (DD1834905) for  
more information.  

1. In the Venus 7000 Shell, open the V7 VLink Controller application by clicking the V-Link 
4500 icon or by pressing [V]. The V7 VLink Controller dialog box opens; refer 
to Figure 6.  

2. If the sign to configure does not display in the Sign drop-down box, click the drop-down 
arrow next to Sign and select the sign to control. Users may also highlight the Sign drop-
down box and use the [up] and [down arrows] to select the sign. After selecting a sign, 
the Sign Type automatically populates.  

3. To select which VIP 4500 to control, click the drop-down arrow next to VLink Index and 
select the processor or press [Alt] + [X] and use the [up] and [down arrows] to select it. 
Up to three processors may connect to the Venus 7000 controller per sign.  

4. To select which channel to control, click the drop-down arrow next to VLink Channel and 
select the channel or press [Alt] + [C] and use the [up] and [down arrows] to select it. Up 
to four channels can display per VIP 4500.  

5. Set the video format for each channel. Click the drop-down arrow next to Video Format 
and select the preferred format. Users may also press [Alt] + [M] to move the cursor to 
the Video Format box and use the [up] and [down arrows] to select the video format.  

Note: Auto works well as a format for most applications. 

 

 

Figure 6: V7 V-Link Controller Dialog Box 
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6. Click the drop-down arrow next to Input and select your 
desired input. Users may also press [Alt] + [I] to move the 
cursor to the Input text box and then use the [up] and [down 
arrows] to select the desired input. After completing the setup 
procedure and configuring the settings for this input, adjust 
the settings for each of the other inputs as well.  

7. To make the Time Constant Mode adjustment, click the drop-
down arrow next to Time Const. Mode box and then select the 
preferred mode.  

Note: VTR works well for most applications.  

8. Leave the Data Source setting on Video to play video content 
on the display.  

9. Leave the Position Settings and Color Settings alone; 
adjustments are made in Steps 10-14. Default setting is 
overlay.  

10. Click Details or press [Alt] + [D]. The V7 VLink Controller 
dialog box expands; refer to Figure 9. 

The Viewable Area box determines what portion of the video feed displays. 
The default setting is the largest area of acceptable video feed available for 
display. This feed is centered and may be adjusted as desired. Change the 
Top and Left quantities to move the display area to the desired video 
image area. 

If adjusting the Viewable Area and/or Source Window settings, save those 
settings. Click Save Position Settings or press [Alt] + [V]. A Save Position 
Settings dialog box opens. Type the name of the position settings (for 
example, “Position 1”). Click OK or press [Enter]. This saves the settings 
under the name entered. 
Recall settings using 
Position Settings. 

 

Figure 7: Input Selector 

 

Figure 8: Data 
Source Selector 

 

 

Figure 9: V7 V-Link Controller Dialog Box with Details 
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11. Use the Color Adjustment box to adjust the Brightness, Contrast, Hue, and Saturation of each 
input until they look their best. 

• To adjust brightness, click and drag the Brightness slider or press [Alt] + [N] to 
move the cursor to the Brightness setting. Use the [left] and [right arrows]  
to adjust.  

• To adjust contrast, click and drag the Contrast slider or press [Alt] + [O] to move 
the cursor to the Contrast setting. Use the [left] and [right arrows] to adjust.  

• To adjust hue, click and drag the Hue slider or press [Alt] + [U] to move the 
cursor to the Hue setting. Use the [left] and [right arrows] to adjust.  

• To adjust saturation, click and drag the Saturation slider or press [Alt] + [T] to 
move the cursor to the Saturation setting. Use the [left] and [right arrows]  
to adjust.  

12. After entering the color settings for this input, click Save Color Settings or press  
[Alt] + [E]. A Save Color Settings dialog box opens. Type the name of the color settings (for 
example, “Color 1”) and click OK or press [Enter]. This saves the settings under the 
name entered. Recall settings using Color Settings. 

13. If using overlay, set a key color using Key Color Levels. Press [Alt] + [K] to move the 
cursor to the Key Color Levels box and use [Tab] or [Shift] + [Tab] to move between the 
color level boxes. Use the [up] and [down arrow] keys to set the key color level. 

Note: Daktronics does not recommend changing the key color after setting it. The VIP-4500 
supports 256 intensity levels for each color (0-255). The default setting is Green 247 (Red 0, 
Green 247, Blue 0). Create sequences with key color in mind and use only that color for 
sequences overlaid on video.  

14. For more than one video input, return to the Input menu and select the next input. Adjust 
position or color settings for each input. Be sure to save settings when  
making adjustments.  

15. To manually switch between VIP 4500s, inputs, and data sources in the Venus 7000 Shell, 
press [V] for the processor. The V7 VLink Controller dialog box, shown in Figure 6, opens.  

16. After the VLink dialog box opens, video immediately displays on the default sign. Before 
the event, change the data source to the DMP 7000 controller. To do so, select Venus in 
the Data Source box by clicking the drop-down arrow next to Data Source and choosing 
Venus or by pressing [Alt] + [A] to move the cursor to the Data Source box and then 
using the [up] and [down arrows] to select Venus.  

17. If the sign the VIP 4500 will control does not display in the Sign box, click in the Sign box 
and then select the sign to control. Use the [up] and [down arrow] keys to select the sign 
to control.  
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18. Set the VIP 4500 to control by clicking the drop-down arrow next to VLink Index. Then 
select the desired processor or press [Alt] + [X] to move the cursor to the VLink Index text 
box and use the [up] and [down arrows] to select the desired VIP 4500.  

19. Set the output channel by clicking the drop-down arrow next to VLink Channel or by 
pressing [Alt] + [C] and using the [up] and [down arrows] to select the desired channel. 
Each processor outputs four channels.  

20. When ready to play video on the display, click inside the Data Source text box and 
choose Video or press [Alt] + [A] to move the cursor to the Data Source text box and use 
the [up] and [down arrows] to select Video.  

Note: If the monitor window is open, no video plays on the display because the video 
does not send to the computer. The Venus software data continues on the monitor.  

21. To select a different input from a different VIP 4500 processor, click inside the VLink 
Index text box and select a different processor from the drop-down menu. Then select the 
desired input from the Input drop-down menu. Users may also press [Alt] + [I] to move 
the cursor to the Input text box and use the [up] and [down arrows] to select the  
new input.  

22. To return to the box showing Venus sequences, click the drop-down arrow next to Data 
Source and click Venus or press [Alt] + [A] to move the cursor to the Data Source text box 
and use the [up] and [down arrows] to select Venus.  

23. To go to Overlay Mode, click the drop-down arrow next to Data Source and then click 
Overlayed or press [Alt] + [A] to move the cursor to the Data Source text box and use the 
[up] and [down arrows] to select Overlayed.  

Note: Overlay Mode allows for the display of any desired DMP sequences. Once a 
sequence with the key color displays, video plays inside the key color area 

24. When finished with the V7 VLink Controller dialog box, select Close to close the  
dialog box.  

Note: Spend time practicing the various functions, such as switching between video 
sources and inputs.
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Section 4: VIP 4500 Configuration Using  
Tera Term®  

Initial configuration and property edits of the VIP 4500 are typically accomplished using Venus 7000 
software; generally, this approach is the easiest and most practical. Tera Term® provides another 
method for entering the same parameters and offers the GC (Get Configuration) command, which 
produces a readout of current settings and is mostly used for troubleshooting.  

4.1 Using Tera Term® 
1. Using a serial cable, link the DB-9 connector port on the VIP 4500 to an open COM port 

on the DMP 7000 control computer. The DB-9 port on the VIP 4500 console is 
immediately to the left of the VMax4TM Input port. 

Note: Make sure the processor is turned on and Venus® 7000 sign service is stopped. 

2. Open Tera Term® and go to Setup > Serial Port.  

3. In the Port field, enter the COM 
port on the DMP 7000 connected to 
the VIP 4400. 

4. In the Serial Port setup window, 
configure the port settings as 
shown in Figure 10. 

• Bits per second: 115,200 

• Data bits: 8 

• Parity: None 

• Stop bits: 1 

• Flow Control: None 

 

 

Figure 10: COM Properties Box 
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4.2 Initial Setup 
Running the video processor for the first time requires entering configuration parameters. 
The preferred method uses the Venus® 7000 software to enter the parameters. However, a 
user can enter these commands from Tera Term® window. Section 7: VIP 4510 Converter 
explains all available commands and their key combinations. 

The following example lists the commands for configuring a 480 x 640 display with one video 
input. Section 7: VIP 4510 Converter details the proper usage syntax. 

 

Figure 11: Tera Term® Sample Configuration 
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1. SI 1—video input selection.  

• 1 indicates a composite video source. 

• Values 1-4 set composite as the input source. 

• 11-14 set S-Video. 

• 21-24 set component. 

• 31 and 32 set VGA. 

• 41-44 set SD-SDI. 

• 51 and 52 set DVI. 

2. VA 0 0 480 640—adjusts the incoming signal’s dimensions by a starting point  
and lengths.  

• The first 0 indicates the vertical start location. 

• The second 0 indicates the horizontal start location. 

• 480 sets the pixel height the VIP 4500 video processor controls. 

• 640 sets the pixel width the VIP 4500 processor controls. 

3. WA 0 0 480 640—adjusts the channel’s output dimensions by a starting point  
and lengths.  

• The first 0 indicates the vertical start point of the window. 

• The second 0 indicates the horizontal start point of the window. 

• 480 sets the value for the window height. 

• 640 sets the window length. 

4. VB 128—video brightness.  

• 128 sets the video brightness level. 

• The default value is 128. 

• The range is 0-255. Zero is full black and 255 is full white. 
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5. VC 64—video contrast.  

• 64 sets the video contrast level. 

• The default is 64. 

• The range is 0-127. 

6. VH 128—video hue.  

• 128 sets the video hue.  

• The default value is 128. 

• The range is 0-255. 

7. VS 64—video saturation.  

• 64 sets the value for video saturation.  

• The default value is 64. 

• The range is 0-127. Zero is full black and 127 is completely saturated. 

8. CS 480 640—display size.  

• 480 sets the height in pixels. 

• 640 sets the width in pixels. 

9. SP 26 1 480 640—absolute sign position. 

10. DF 1—display face enable.  

• A value of 1 enables face A. 

11. DD 127—display dimming.  

• 127 sets the value for display dimming. 

• The default value is 127. 

• The range is 0-127. 

• A value of 0 is completely dim and the display appears black. 

• A value of 127 is at full brightness and the display appears white. 
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12. DG 32—display gamma.  

• 32 sets the data distributor gamma value.  

• The range is 10-41, which is 1.0 to 4.1. 

13. DP 0 0 240 640—relative data distributor position. 

14. CR 48 48 48 48 48—configure rows.  

15. CC 256 256 128—configure columns.  

16. DN 1—data distributor number select.  

• 0 sets to which data distributor the VMax4 signal routes. 

• 1 sets the other data distributor in the display that receives VMax4 signal.  

• The range is 0-15. 

17. DP 240 0 240 640—relative data distributor position.  

18. CR 48 48 48 48 48—configure rows. 

19. CC 256 256 128—configure column. 

20. SS I—source selection.  

• I sets the data type to Video.  

• V sets the DMP 7000 controller as the data source. 

• O selects Overlay, which displays DMP 7000 data over video signal. 

• C sets the Chroma mode.  

21. Check that all other parameters are set as shown in Figure 11.  

Note: To avoid losing these settings, do not power the processor off and on. To save the 
settings, enter the command “CF S”.
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Section 5: VIP 4500 Configuration Using V-Tour® 

5.1 The V-Link Window 

Follow these steps to configure the VIP: 

1.  Enter the desired name for the processor. Use descriptive names (e.g., VIP, Left VIP, 
Right VIP). 

2. Choose Network or Serial in the Communications box. 

a. If Network is chosen, enter the corresponding IP address.  

Note: Use the buttons on the front panel of the VIP 4500 console to scroll through 
the options until the IP address is found. 

b. If Serial is chosen, select the Port. 

Note: The port must be different than the port selected in the display window. 

3.  Choose the V-Link Type. Refer to the series number on the console face. 

4.  Click Next. The Summary window opens. 

 

Figure 12: New Configuration-Network 

 

Figure 13: New Configuration-Serial 
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5.2 The Summary Window 
The Summary window overviews information entered on the Display and V-Link windows. 

Note: If the options listed on the Summary window are incorrect, click Previous to adjust. 

If the summary is correct: 

1. Click Finish. The Send 
Configuration dialog box opens. 

2. From the File menu, select 
Import System Configuration. 

3. Select the appropriate *.vcd file 
from the Open window. 

4. Click the Open button. 

 

Figure 14: Configuration Wizard 

 

Figure 15: Send Configuration Confirmation 
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Saving a Complete Display: 
1. From the File menu, select  

Export System Configuration. 

2.  In the Save window, name the display 
configuration and verify that the default 
file extension is *.vcd, and click the  
Save button. 

3. Adjust the VMax Pipe Size, if necessary. 

Note: By default, the V-Max Pipe Size is 
set to 720 x 848 and 60 frames per second. 
The V-Max Pipe Size must be larger than 
the display’s dimensions, so it is only 
necessary to adjust the Pipe Size when it is smaller than the display.  

4. Select the Channel from the Channel drop-down menu. 

5. Select the Input from the Input Selection drop-down menu. Verify that all Edge Blending 
settings are correct. 

6. Click Send EdgeBlending Commands. 

7. Repeat Steps 2-6 with the remaining VIPs and columns in the display. 

Note: To reset all of the fields in the Edge Blending to default settings, click Reset to 
Defaults. To close Edge Blending, click Close EdgeBlending. 

V-Link Tool Tab 
The advanced features in this section alter VIP settings for various display configurations 
such as small, long and thin, or multiple displays. 

Positional PixelingSM
 

Positional Pixeling uses proprietary algorithms to control individual LEDs within each pixel, 
enhancing sharpness on smaller displays. This option smoothes edges, diagonal lines, and 
curves, which provides a crisper image. Use this feature at all times with displays less than 
240 pixels in height and 320 pixels in width. 

To enable Positional Pixeling: 

1. Navigate to the Tool tab within the V-Link page tab. 

2. Check the Positional Pixeling box. 

3. Set the V-Max Pipe Size so it is at least two times the height and two times the width of 
the display, measured in pixels. 

 

Figure 16: Export System Configuration 
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Adjusting V-Max Pipe Size 
V-Max Pipe Size resizes the VMaxTM signal without changing the number of pixels the signal 
can control. This feature is useful when configuring long, thin displays or multiple displays. 

To adjust the V-Max Pipe Size: 

1. Navigate to the Tool tab within the V-Link page tab. 

2. Select the appropriate FPS (Frames per Second). Most applications require 60 FPS, as 
NTSC signal requires this setting. 

3. Choose the appropriate dimensions from the drop-down menu. The first option is 
labeled Default. The option below the default is the longest horizontally and the 
narrowest vertically. Continuing down the menu, dimensions become narrower 
horizontally and taller vertically. 

Guidelines for Assigning Pixel Pitch 

Displays with One Pixel Pitch 
If a display uses panels with a single pixel pitch, the pixel size should equal the pixel pitch. 
For example, a display using only 8 mm ProTour® panels should have the pixel size of 8 mm. 

Displays with Panels of Different Pixel Pitches 
The pixel size must be large enough for the display to fit into the VMaxTM frame. Standard 
VMaxTM frame size is 720 x 848 pixels. Pixel size cannot be larger than the smallest pixel pitch 
in the display. 

Be aware of the video input size. To maintain 1:1 mapping, the pixel size must stay within the 
size of the video input; otherwise the video input will need to be stretched. To obtain the best 
quality picture, figure the greatest common divisor of all pixel pitches used in the display 
and enter that number for the pixel size. 

Note: The greatest common divisor (GCD) is the largest number that divides into a set of 
numbers without leaving a remainder. For example, given the set of 8 and 20, 4 is the GCD. 

Displays with Angled Panels 
Note: Angling HD panels is not recommended. 

The pixel size must be large enough for the display to fit into the VMaxTM frame. Standard 
VMaxTM frame size is 720 x 848 pixels. Pixel size cannot be larger than the smallest pixel pitch 
in the display. 

Be aware of the video input size. To maintain 1:1 mapping, the pixel size must stay within the 
size of the video input; otherwise the video input will need to be stretched. 
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Angling panels require some distortion of the image; however, the goal is to minimize the 
distortion. There is no simple method for figuring the pixel size. Start by entering one-half or 
one-third of the pixel pitch in Set Pixel Size and check the distortion of the video image. 

Other values may be used, but they may distort the image. Smaller pixel sizes create a clearer 
image, but remember to stay within the VMaxTM frame. 

Another method of checking the distortion of an image is to view the translation table. To do 
this, open the *.png file in Microsoft®

 Paint. For assistance in viewing the Translation Table, 
see the next section, Advanced Saving. 

Advanced Saving 
Save Configuration and Save Optimized Translation Table offer specialized saving features for 
complicated configurations, such as angled panels or multiple controllers. 

Save Translation Table 
Save Translation Table saves .hex files of translation tables that send to the display and creates 
.png files that provide visual representations of the translation tables. The .png files map 
pixel coordinates in relationship to the VMaxTM frame. Save Translation Table creates one 
translation table and one .png for each controller in the configuration. 

To save a translation table: 

1. In the Wiring tab, select File > Save > Save Translation Table. The Browse for Folder 
window opens. 

2.  Navigate to or create the desired folder to store the files and select it. 

3. Click OK. 

Save Optimized Translation Table 
Save Optimized Translation Table creates text files listing the controller offsets and the DP 
commands needed for VIP setup, in addition to saving the translation tables and the PNGs. 
Unlike the PNG and JPG files, only one offsets.txt file is generated per configuration, rather 
than one for each controller. Use this saving method with configurations that have multiple 
controllers. 

1. In the Wiring tab, select File > Save > Save Optimized Translation Table. The Browse for 
Folder window opens. 

2. Navigate to or create the desired folder to store the files and select it. 

3. Click OK. A confirm save dialog box opens. 

4. Click Yes to confirm the save. Clicking No cancels the save and goes back to the  
previous screen. 
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Configuration of Angled Panels 
Some customers may want some or all panels to be tilted without tilting the content. This 
section guides users through the V-Tour® setup for angled configurations. 

The first step in creating rotated V-Tour® configurations is to set the pixel size.  

Note: Daktronics cautions against changing pixel size manually due to the possibility of 
picture degradation as V-Tour automatically adjusts pixel size. 

1. Navigate to the Wiring tab within the System page tab. 

2. Open the Current tab on the right side of the Wiring screen. 

3. Select the panel(s) to rotate. Information about the panel(s) appears in the Currently 
Selected tab. 

4. Type the desired angle of rotation in the Angle field, located under Measurement in the 
Current tab. 

5. Go to the menu bar and click Tools > Set Pixel Size. Enter “1” in the Set Pixel Size text 
box and click OK. 

6. Click Send to send the configuration to the display. 

Adjusting Precision 
Adjusting alignment precision ensures proper pixel size after rotation, eliminating 
overlapping pixels. 

1. Open the Wiring tab in the System page tab. 

2. Click Set Precision under Tools in the menu bar. The Set Alignment Precision dialog  
box opens. 

3. Adjust Set Precision and Set Grid to the desired levels and click OK. The objects snap into 
the created grid.  

• Precision sets the unit used for each grid line.  

• Grid sets the number of grid lines
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Section 6: Advanced Operation 

The procedures in this section allow a user to optimize or troubleshoot the VIP 4500. Given the 
advanced nature of the procedures listed, it is recommended that users perform them under the 
supervision of Daktronics service personnel.  

6.1 Adjusting Screen Color Balance 
For proper color display, using a color pattern generator is essential. The connection allows 
for SMPTE bars to display on a Daktronics LED video display. 

SMPTE bars are multi-purpose test patterns used as an adjustment reference to verify the 
correct operation of a video display. Refer to Figure 17. 

With the CalibarTM attached so the bars display on the Daktronics LED video display, perform 
the following steps:  

1. Adjust the contrast so the white reference square 
in the lower-left corner looks bright and clean. 
The white should not spread or bleed into the 
darker squares surrounding it.  

2. Adjust the display brightness so the three small 
gray and black rectangles near the bottom-right of 
the pattern are clearly visible; this area is called 
the PLUGE. Reduce the brightness just until the 
line separating the first and second  
rectangles disappears. 

3. If a vectorscope or waveform monitor is present, use the SMPTE bars to check system 
gain by feeding the pattern to the Daktronics LED video display and to the monitor with 
the scope. 

The video line feeding the WFM must end in one 75-ohm termination. Color bars appear on a 
WFM as six vertical, shaded rectangles called chips. The white reference square of the pattern 
shows up on a WFM as a line at the top of the yellow and cyan chips. Using the vertical 
position on the WFM, center the blanking level at 0 IRE. Adjust the video device’s gain to 
place the line of white reference square at 100 IRE. When the low-pass filter is selected on a 
WFM, IRE levels should be as follows: 

• Gray 77 • Green 48 

• Yellow 69 • Magenta 36 

• White 100 • Red 28 

• Blue 56 • Blue 15 

 

Figure 17: SMPTE Test Bar Display 



 

26 Advanced Operation 

Feeding a video device with SMPTE bars and then 
feeding the signal into a vectorscope and terminated 
monitor allows for checking the chroma phase. Select the 
75 percent bars gain button on the vectorscope, and turn 
the phase knob to line up with the reference flag to 0 
degrees. The points of the displayed pattern land inside 
the squares for each color vector.  

6.2 Resetting VIP to Factory Defaults 
Certain issues require the VIP to be reset to its factory 
defaults. Confirm the following before resetting  
the VIP. 

1. No video output is visible on the display. 

2. Bypass the VIP to verify the VMaxTM signal  
works correctly. 

3. Ensure functionality of inputs via VIP  
web monitoring.  

Note: If web monitoring is unavailable, do not reset 
the VIP. 

4. Verify the system configuration and display are 
working correctly by switching to the backup 
system (if available). 

Locate the backup configuration settings before reset, as the factory reset process will remove 
any configuration on the VIP. In the absence of a functional configuration backup, the 
configuration must be re-entered manually. Typical locations include Venus 7000 scripts or 
command frames, as well as .VLC files. 

Note: Save the configuration as a new file. 

1. Open the VLink Debugger. The VLink Debugger can be found under the Start menu in 
Programs > Venus 7000 > Venus 7000 Tools > V7 VLink Debug. For more information 
on the V7 VLink Debugger, refer to DMP-7000 Installation and Setup  
Manual (DD1834905). 

2. In the VLink Debugger Command box, type “XRD,” which deletes all configuration 
settings and restarts the VIP. Refer to Figure 18. 

3. Wait one minute to allow the VIP to reboot, then type “XR” and click Send Command. 
Allow a minute for the VIP to reboot, then click [Enter] while the cursor is in the VLink 
Debugger Command box. When 1> appears in the readout window, the VIP has 
completed the reboot. Refer to Figure 19. 

 

Figure 18: Entering “XRD” Command 

 

Figure 19: Completed Reboot 
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4. Reload the configuration settings at this time. 

5. If settings are in a Venus 7000 script file or command 
frame, run that file now; if not proceed to Step 7. 

6. If there are .VLC files for each VIP channel, follow these 
steps: 

a. On the Venus 7000 shell, click the VLink button in 
the bottom right corner. Refer to Figure 20. 

b. Select the sign connected to the VIP located in the 
Sign window. Refer to Figure 21. 

c. Confirm the channel is set to VLink Channel 1 and 
click the Details button on the lower left. Refer to 
Figure 22.  

d. Click the Send Configuration Settings button on 
the bottom left. Refer to Figure 23. 

e. Browse to the location of the .VLC files and load the 
configuration for Channel 1 by selecting a file and 
clicking Open. Refer to Figure 24. 

f. VLink Configuration window will appear. 
Click OK. Refer to Figure 25. 

g. Repeat the previous step for Channels 2 
through 4. 

Note: If no functional configuration backup is 
available, the configuration will need to be re-
entered manually. 

 

Figure 20: Venus 7000 Shell 

 

Figure 21: Selecting Sign 

 

Figure 22: Details 

 

Figure 23: Sending Configuration Settings 

 

Figure 24: Loading Configuration 

 

Figure 25: VLink 
Configuration Window 
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7. After running the initialize script or command 
frame, or loading all the necessary .VLC files, save 
the configuration on the VIP by entering “CF S” in 
the V7 VLink Debugger Command box. Create 
backup configuration if not done previously. Refer 
to  Figure 26.   

Note: The CF S command only needs to be entered 
once to save all four channel configurations. 

8. Test the configuration of the site under their 
normal operation scenario.  Contact an on-site 
operator for help running this test. 

6.3 Creating a .VLC file 
A .VLC file functions as a backup configuration file 
external to the VIP 4500. Create .VLC files after 
completing initial setup or changing the 
configuration. 

1. Open the Venus 7000 shell. 

2. On the Venus 7000 shell, click the VLink button 
in the bottom right corner. Refer to Figure 20. 

3. In the Sign window in the upper left, select the 

sign connected to the VIP. Refer to Figure 21. 

4. Confirm the channel is set to VLink Channel 1 
and click the Details button on the lower left. 
Refer to Figure 22. 

5. Click the Save Configuration Settings button 
in the bottom left corner. Refer to Figure 27. 

6. Browse to the location where you intend to 
save the .VLC file.  Choose a descriptive name 
for the .VLC file that would make it easy to 
determine which .VLC files go to which VIP and which channels. It is also recommended 
to include the date. For example, a .VLC file for Channel 1 on a VIP that controls the left 
display half might be named Left_CH1(5-19-11).VLC. Refer to Figure 28. Click Save 
when finished. 

7. Repeat this process for each channel of the VIP.  

 

Figure 26: Send Command 

 

Figure 27: Save Configuration Settings 

 

Figure 28: Saving .VLC File 



 

Advanced Operation 29 

6.4 Instructions on how to make a backup 
script file 
Follow the instructions below to create a backup script for the 
VIP 4500. For additional information, refer to the DMP-7000 
Installation and Setup Manual (DD1834905). 

1. Follow the instructions in Section 6.3 to create your .VLC 
files before proceeding. 

2. On the V7Dsply scripting page, right click on an unused 
cell and select Edit Cell. Refer to Figure 29. 

3. A pop-up window will appear where you will either 
enter in the name of the script file you are looking for, or 
name a new one. This example uses the name backup. 
Click OK to continue. Refer to Figure 30. 

4. Right click on cell described in Step 2 and select Edit 
Script File. Refer to Figure 31. 

5. The Edit Script pop-up window will appear. Click the Add 
Line button to create a scripting line. Refer to Figure 32. 

6. Select the scripting command VLSendConfig File then click 
the Next button. Refer to Figure 33. 

7. Click Select Sign to select the sign connected to your VIP. 
When complete, click the Next button. Refer to Figure 34. 

 

Figure 29: Edit Cell 

 

Figure 30: Pop-up Window 

 

Figure 31: Edit Script File 

 

Figure 32: Add Line 

 

Figure 33: Selecting Command 

 

Figure 34: Select Sign 
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8. Click Select Path to navigate to the location of 
the .VLC file you created for Channel 1. Then 
click the Next button. Refer to Figure 35. 

9. Select the appropriate VIP index number and 
channel for the VIP you are using. In this case, 
it is Index 1 and Channel 1. Then click the Next 
button. Refer to Figure 36. 

10. The Verify Scripting Command window will 
appear. Visually confirm that the script is 
correct, then click the Finish button to create 
the scripting command and take you back to 
the Edit Script window. Refer to Figure 37. 

11. Repeat Steps 4-10 to add more  
channel configurations. 

12. Navigate to the location the .VLC file(s) created 
in Step 10 and open it as a .txt file in Notepad. 

13. Erase all the current settings, and replace them 
with “cf s”. Refer to Figure 38.  

14. In Notepad, click File>Save As and enter ithe 
name “CF S.VLC” into the File name. Be sure to 
include the quotations, as this ensures that the 
file saves as a .VLC. Refer to Figure 39. 

15. Repeat Steps 4-10, this time adding the  
CF S.VLC file to the script. When run, this 
scripting line will save the configuration on to 
the VIP. Refer to Figure 40. 

 

 

Figure 35: Navigating to .VLC File 

 

Figure 36: Setting Values 

 

Figure 37: Verifying Scripting Command 

 

Figure 38: Erasing and 
Replacing Current Settings 

 

Figure 39: Saving as .VLC 

 

Figure 40: Saving Configuration to VIP by 
Running Script 
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Section 7: VIP 4510 Converter 

The processor has a built-in component that can send the processor output to a confidence monitor. 
This component, known as the VIP 4150 converter, supports the following standards: composite,  
S-Video, component, VGA and DVI standards.  

7.1 Basic Setup 
To set up the VIP 4510 converter, three basic commands need to change. Those commands 
are viewable area (VXVA), window area (VXWA), and video format (VXVF). To check these 
numbers, type “VXGC” into the V7 VLink Debugger or into Tera Term®.  

The viewable area should be set to the sign size of the LED display. The window area should be 
set to the resolution of the monitor. The video format needs to be set to the correct format for the 
VIP 4510 converter to output on the monitor. See the chart below in Section 9.8 for the 
different formats.  

Note: In a system with two VIP 4500s, each VIP 4510 needs to be configured so that the 
viewable area is the same as the window area (WA) of the associated VIP. To do this, use the 
controller interface software to check the window area fields.

 

 

Figure 41: VIP 4510 Converter 
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Section 8:  Front Panel Instructions 

Many of the video processor settings can be changed through the Front Panel Interface.  
To scroll through the settings, use the left and right arrows. To change a setting, use the up and down 
arrows. When you have the setting at the desired value, use the middle button to apply the settings.  

Note: The settings are not saved until you save the configuration. Rebooting the processor 
will cause the settings to revert. The configuration using the front panel under the 
Configuration (CF) setting to the last saved configuration.  

Here is a list of the settings that can be changed through the front panel:  

• Channel  

• Set Input  

• Edge Blending  

• Viewable Area Top  

• Viewable Area Left  

• Viewable Area Height  

• Viewable Area Width  

• Window Area Top  

• Window Area Left  

• Window Area Height  

• Window Area Width  

• Transparency  

 

Figure 42: Front Panel 
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• Brightness  

• Contrast  

• Hue  

• Saturation  

• Vertical Filter (1-8) 

• Horizontal Filter (1-8) 

• Overlay Color (Red Value)  

• Overlay Color (Green Value)  

• Overlay Color (Blue Value)  

• VMax4 Active Width  

• VMax4 Total Width  

• VMax4 Active Height 

• VMax4 Total Height 

• VMax4 Clock Divider 

• VIP4500 ID (SV row) 

• VIP4500 ID (SV col) 

• VIP4500 ID (SV total row) 

• VIP4500 ID (SV total col) 

• VMax4 Transparency (AV) 

• VMax4 Color Red (VK) 

• VMax4 Color Green (VK) 

• VMax4 Color Blue (VK) 

• Chroma Range (KR) 

• Set Source (Video, Venus, Overlay, Chroma) 

• Z-Order 
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• Dimming  

• Gamma 

• Configuration Save/Delete (CF s/d) 

• Set IP (IP xxx.xxx.xxx.xxx) 

• Set Netmask (NM xxx.xxx.xxx.xxx) 

• Show Versions (GV) 
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Section 9: Web Page Navigation 

The web pages hosted on the VIP-
4500 contain formats that allow the 
user to change the configuration of 
the VIP-4500. Input sources and 
channel outputs may also be 
monitored through the web page.  
The processor’s webpage requires a 
network connection and a static IP 
address to function properly. The 
IP address and the Net Mask of the 
network need to be configured only 
once on the processor.  

To access the webpage, type the IP address into Internet Explorer. This will bring you to the main 
page. You may then go to the different sections.  

Channel Configuration 

• Input Source 

• Viewable Area 

• Window Area 

• Alpha control 

• Brightness control 

 

 

Figure 43: Web Page 

 

 

Figure 44: Channel Configuration Page 
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• Contrast control 

• Hue control 

• Saturation control 

• Sharpness Filter 

General Configuration  

• VMax4 Frame Rate 

• Vmax4 Frame Size 

• Interleave Mode 

• Interleave Mask 

•  Z-Order 

 

Figure 45: General Configuration 
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Sign Configuration 

• Gamma control 

• Dimming control 

Set Default Configuration 

• Saves the current configuration on the processor as the default 

 

 

Figure 46: Sign Configuration 

 

 

Figure 47: Set Default Configuration 
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Download 

• Downloads a 7000 VLC file containing configuration settings for all four VIP 
channels 

Imaging 

• Display an image of the selected video source, channel, or incoming/outgoing 
VMax4 signal 

 

Figure 48: Download Utility 

 

 

Figure 49: Video Source to Capture 
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Get Config Utility 

• Reports the current configuration of the selected processor channel 

Get Status Utility 

• Reports the current status and resolution of the incoming video signals and  
processor channels.  

Update Firmware Utility 

• Allows the user to update firmware on the processor 

 

 

Figure 50: Get Config Utility 

 

 

Figure 51: Get Status Utility 

 

 

Figure 52: Update Firmware Utility 
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Reset Utility 

• Resets the VIP from the Web, performs an “XR.” 

 

 

Figure 53: Reset Utility 
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Section 10: Command Reference 

10.1 Channel-Specific Commands 

Command Description Definition Example/Default 

CH x Channel Select (1-4) Shows the  
channel number 

CH 1 

SI x Video Input Selection 
• 1-4 = composite 
• 11-14 = S-Video 
• 21-24 = Component 
• 31, 32 = VGA 
• 41-44 = SD-SDI  
• 51, 52 = DVI 

Assigns an input 
number to video 

SI 41 

EB x Edge Blending (0-1) Blends left side of video 
to remove border on left 
side. Used for 
combining two channels 
or two VIP 4500s to be 
seamless. This is a read  
only command 

EB 1 

VA t l h w  Viewable Area 
• t=top start 
• l=left start 
• h= height  
• w=width  

Extracts the location 
and dimensions of the 
selected source. 

VA 0 0 480 640 

WA t l h w Window Area 
• t=top start 
• l=left start 
• h= height  
• w=width 

Adjusts current 
channel’s output 
location on 
the display  

WA 0 0 480 640 

AA t l h w  Active Area 
• t=top start 
• l=left start 
• h= height  
• w=width 

Adjusts the active 
dimensions of each 
window by defining a 
starting point and 
lengths 

AA 0 0 480 640  

FI x Video Transparency (0-256) Adjusts Video Fade FI 256 

VB x Video Brightness (0-255) Adjusts Sign Brightness VB 128 128 128 

VC x Video Contrast (0-127) Adjusts Contrast Ratio VC 64 64 64 

VH x Video Hue (0-255) Adjusts Hue levels  VH 128 
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Command Description Definition Example/Default 

VS x Video Saturation (0-127) Adjusts the Saturation 
Level 

VS 64 

FV x Vertical Filter (0-9) Adjusts the Vertical 
sharpness Filter 

FV 5 

FH x Horizontal Filter (0-9) Adjusts the Horizontal 
sharpness Filter 

FH 5 

FF x Freeze Frame 
• 0 = off  
• 1 = on 

Freezes the frame FF 0 

SK r g b Key color (0-255) Sets the Key Color SK 0 247 0 

DE x y Detail Enhancement (0-63) 
• x = detail level 
• y = detail noise threshold 

Sets the noise and 
filtering levels 

DE 0 0 

NR x Noise Reduction (0-63) Sets amount of Noise 
Reduction applied  
to image 

NR 0 

BC r g b Border Color (0-255) Sets the Border Color BC 0 0 0  

BT n Border Thickness (0-128)  
• reads out as a percentage 

Sets the thickness of 
the border as a 
percentage of image 
height 

BT 0% 

BE x Border Enable (0-1) Activate the Border BE 0 

AR x Aspect ratio 
• ANA = anamorphic 
• PAN = panoramic 
• LTR = letter box 
• EXT = extract 
• THR= through 

Sets the Aspect Ratio AR ANA 

MD x Motion Detection (0-1) Activates Motion 
Detection operation 
during deinterlacing 

MD 1 

MT x Motion Threshold (0-15) Sets the Motion 
Threshold detection 
parameter 

MT 10 

FD x Freeze frame Detection 
• D – Disabled 
• T – T Compensation 
• V – VT Compensation 

Sets the quality of the 
deinterlacer 

FD v 
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Command Description Definition Example/Default 

FT x Freeze Frame Threshold (0-7) Sets the Freeze  
Frame Threshold 

FT 7 

DM x Deinterlace Mode 
• A – fully Adaptive 
• F – field Merging 
• T – temporal Only 

Determines deinterlacer 
operating mode 

DM a 

10.2 Additional Configuration 

Command Description Definition Example/Default 

BS t l h w  Background Size 
• t=top vertical start point 
• l=left horizontal start point  
• h= window height  
• w=window width 

Sets the Background 
Size 

BS 26 1 720 848 

FG haw hbw vas vae 
ve fr 

VMax4 Frame Generation 
• haw=horizontal active width 
• hbw=horizontal blank width 
• vas=vertical active start 
• vae=vertical active end 
• ve=vertical end 
• fr=frame rate 

Sets Frame 
Generation 
parameters 

FG 1280 358 26 745 
750 0 

SD r c  Set Display Dimensions  
• r=rows  
• c=columns  

Sets the overall 
physical sign 
dimensions 

SD 720 848 

SV vi hi vt ht  Set VIP Index  
• vi=verticall index 
• hi=horizontal index 
• vt=vertical total 
• ht=horizontal total 

Sets the position of 
the VIP on the 
display  

SV 1 1 1 1 

FGC r g b Frame Generation Color (0-255) Sets the Frame 
Generation Color 

FGC 0 247 0 

AV x VMax4 Transparency (0-256) Controls 
transparency of 
incoming VMax4 
content  

AV 256 

VK r g b VMax4 Key Color (0-255) Sets the VMax4 Key 
Color  

VK 0 247 0 
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Command Description Definition Example/Default 

KR x Chroma Range (0-255) Adjusts how far the 
key color can be 
from the center 
value (set by SK and 
VK) to key the 
channel. Only 
applicable in 
Chroma mode 

KR 10  

VF x Video Format 
• A = Auto-Detect,  
• NJ = NTSC-J 
• N = NSTC-M 
• P6 = PAL-60 
• N4 = NTSC 4.43 
• P = PAL B/G,D/K,H,I 
• PN = PAL-N 
• PMw = PAL-M(without pedestal) 
• PM = PAL-M 
• PNc = PAL-Nc  
• PNcw = PAL-Nc(with pedestal) 
• S = SECAM 
• Sw = SECAM(with pedestal) 

Sets the processor 
to a specific video 
input format 

VF A 

XD x Frame Delay (0-63) Delays video by the 
selected amount of 
frames. The 
maximum delay is 
determined by the 
number of active 
pixels in the  
VMax4 frame 

XD 0 

SS x Source Selection 
• V = Venus® controllers 
• I = video 
• O = overlay 
• C=Chroma 

Selects the 
processor  
output source. 

SS I 

ZO x1 x2 x3 x4 x5 Channel Z-order (0-4) 
• 0=VMax 
• 1-4=Channel 

Sets z-order  ZO 1 2 3 4 0 
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Command Description Definition Example/Default 

PS tl tc tr cl cc cr bl bc 
br 

Post Sharpening (-71 to 55) 
• tl=top left 
• tc=top center 
• tr=top right 
• cl=center left 
• cc=center center 
• cr=center right 
• bl=bottom left 
• bc=bottom center 
• br=bottom right 

Sharpening that is 
applied to all video 
channels  
after processing. 

PS 0 0 0 0 32 0 0 0 
0 

IL x r c Interleave Mode 
• x = 1 (enable) or 0 (disable) 
• r = row pattern (0-4) 
• c = column pattern (0-4) 

Activates Interleave 
Mode and sets 
interleave pattern 

IL 0 2 2 

ILM xxxx… Interleave Matrix Sets the  
Interleave Matrix 

ILM 
0770000000000000 

CK x Channel Key (0-3) 
• 0=Luma keying disabled 
• 1-3=Channel Select, enables Luma 

keying on channel 

Selects which 
channel is keyed 
 on Luma 

CK 0 

CKL x x Channel Key Limits (0-1023) Sets Luma  
Key limits 

CKL 64 960 

10.3 Display Configuration 

Command Description Definition Example/Default 

VY  VMax4 Frame Rate (Read Only) Displays VMax4 
Frame Rate (Hz) 

VY 59.94 

SN n Sign Number (0-14) Assigns the Sign 
Number 

SN 0 

CS x y Display Size 
• x = rows 
• y = columns 

Determines the Sign 
Size 

CS 480 640 

SP t l h w  Sign Position (absolute) 
• t= top start point 

• l = left start point 

• h = window height 

• w = window width 

Sets the absolute 
Sign Position 

SP 26 1 480 640 
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Command Description Definition Example/Default 

CT 11 Sign Color technology Sets the Sign Color 
technology 

CT 11 

DF x Face enable Mask (0-16) 
• parameter is hex mask 

Enables the number 
of active faces 

DF F 

DD x Display Dimming (0-127) Controls dimming 
from white to black 

DD 127 127 127 127 

MG x Gamma Method (0-6) Sets the  
Gamma Method 

MG 0 

DG x Gamma Value (10-14) Sets the  
Gamma level 

DG 28 28 28 28 

DX Rr Rg Rb Gr Gg 
Gb Br Bg Bb 

Color Correction values (-32768 to 
 32767) 
• Rr=Red red 
• Rg=Red green 
• Rb=Red blue 
• Gr=Green red 
• Gg=Green green 
• Gb=Green blue 
• Br=Blue red 
• Bg=Blue green 
• Bb=Blue blue 

Configures the data 
display color 
correction 

DX 32767 0 0 0 
32767 0 0 0 32767 

10.4 Data Distributor Configuration 

Command Description Definitions Example/Default 

GCSx Get Sign Configuration (0-14) Displays 
configuration of 
specified 
sign number 

GCS0 

DP t l h w Data Distributor Position (relative) 
• t = top start point 
• l = left start point 
• h = window height 
• w = window width 

Sets Data  
Display Position 

DP0 0 0 240 640 

CR r1 r2 c3 c4 Configure Rows Configures 
selected rows 

CR0 48 48 48 48 48 

CC c1 c2 c3 c4 Configure Columns Configures  
selected columns 

CC0 256 256 128 
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10.5 Effect/Transitions 

Command Description Definition Example/Default 

TE0 ch a t Fade Video  
• ch = channel (0-4) 
• a = alpha (0-256) 
• t = time (milliseconds) 

Sets and adjust 
channel source or 
VMax4 fade 

TE0 1 2556 5000 

TE3 ch t l t Move WA 
• ch = channel (1-4) 
• t = top start point 
• l = left start point 
• t = time (milliseconds) 

Sets and adjusts 
channel window 
area location 

TE3 1 250 250 1000 

TE4 ch i e t Wipe AA 
• ch = channel (1-4) 
• i = out/in (0-1) 
• e = effect pattern (0-10) 
• t = time (milliseconds) 

Uses wipe transition 
to turn channel 
on/off 

TE4 1 1 10 5000 

TE5 ch t l h w t Move/resize WA 
• ch = channel (1-4) 
• i = out/in (0-1) 
• e = effect pattern (0-10) 
• t = time (milliseconds) 

Resizes and moves 
channel  
window area 

TE5 1 0 0 720 848 
10000 

10.6 Miscellaneous Commands 

Command Description Definition Example/Default 

CF x Configuration 
• S = save 
• D = delete 

Saves or deletes a 
configuration 

CF S 

GC Get Configuration Displays the current 
channel’s 
configuration 

GC 

GI Get ID Displays the 
processor ID 

GI 

GS Get Status Display video input, 
channel, and VMax4 
status 

GS 

GSV Get Status Video Displays detailed 
video input, channel, 
and VMax4 status  

GSV 
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Command Description Definition Example/Default 

GSX Get Status ( Venus parseable)  Displays video 
status in a format 
that is parseable by 
Venus 7000 
software.  

GSX 

GV Get Version Reports all 
version numbers 

GV 

XR eXternal Reset Resets processor  XR 

XRD eXternal Reset+Delete Config Deletes 
configuration and 
resets processor 

XRD 

H Help Menu Displays Help Menu H 

IP xxx.xxx.xxx.xxx IP <address> Sets IP address IP 192.168.0.160 

IP r Returns current IP address Displays the IP 
address 

IP r 

NM xxx.xxx.xxx.xxx Net Mask Sets net mask NM 255.255.0.0 

NM r Returns current Net Mask Shows net mask  NM r 

10.7 VIP 4510 Commands 

Command Description Definition Example/Default 

VXVA t l h w Viewable Area 
• t= top start point 
• l = left start point 
• h = window height 
• w = window width 

Adjusts the VIP 
4510 
viewable area 

VXVA 0 0 480 640 

VXVB x Video Brightness (0-255) Adjusts the video 
brightness through 
the VIP 4510 

VXVB 128 

VXVC x Video Contrast (0-128) Adjusts the video 
contrast through the 
VIP 4510 

VXVC 64 

VXVF x Video Format 
x = VIP 4510 video format command 
(refer to Section 10.8) 

Adjusts the output 
video resolution 

VXVF R0 

VXVH x Video Hue (0-255) Adjusts the video 
hue through the  
VIP 4510 

VXVH 128 



 

Command Reference  51 

Command Description Definition Example/Default 

VXVS x Video Saturation (0-128) Adjusts the video 
saturation through 
VIP 4510 

VXVS 64 

VXWA t l h w Window Area 
• t= top start point 
• l = left start point 
• h = window height 
• w = window width 

Adjusts the VIP 
4510’s window area 

VXWA 0 0 480 640 

VXXE x Gamma Enable 
• 1 = enable 
• 0 = disable 

Enables gamma 
through the VIP 
4510 

VXXE 1 

VXXG x Gamma Value Sets the gamma 
value through the 
VIP 4510 

VXXG 10 

VXTPA vf tp rgb Test Pattern Analog  
• vf = test pattern resolution (0-12) 
• tp = test pattern 
• rgb = color (24 bit hex) 

Enables/Disables 
test patterns, sets 
the test pattern type 
and sets the test 
pattern color  

VXTPA 1 1 dda0dd 

VXTPR vf tp rgb Test Pattern DVI/VGA 
• vf = test pattern resolution (0-9) 
• tp = test pattern 
• rgb = color (24 bit hex) 

Enables/disables 
test patterns, sets 
the test pattern type 
and sets the test 
pattern color 

VXTPR 1 6 dda0dd 

VXTPS vf tp rgb Test Pattern SD-SDI 
• vf = test pattern resolution (0-5) 
• tp = test pattern 
• rgb = color (24 bit hex) 

Enables/disables 
test patterns, sets 
the test pattern type 
and sets the test 
pattern color 

VXTPS 2 3 dda0dd 

VXSM x Sync Mode(0-1) Enables the  
Sync Mode 

VXSM 0 

VXWE x Waveform Monitor Enable (0-1) Enables/disables 
Waveform Monitor 

VXWE 0 

VXMS l s Waveform Monitor Start  
• l-line  
• s=sample 

Selects which line 
and sample to view 
on the 
Waveform Monitor 

VXMS 1 0 

VXAR x Auto Refresh (0-1) Turns on/off the 
Waveform Monitor’s 
automatic refresh 
option 

VXAR 1 
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10.8 VIP 4510 Video Format Commands 

Device or 
Mode 

Format Active Size  
(Row x Column) 

Output Type 

A0 NTSC 480 x 640 Composte/S-Video 

A1 NTSC-overscan 480 x 640 Composite/iS-Video 

A2 PAL 576 x 720 Composite/S-Video 

A3 PAL-underscan 576 x 720 Composite/S-Video 

A4 PAL-overscan 576 x 720 Composite/S-Video 

A5 ATSC 480p 480 x 720 Component 

A6 ATSC 720p 720 x 1280 Component 

A6 ATSC 720p (component) 720 x 1280 Component 

A8 NTSC  480 x 640 Component 

A9 NTSC-overscan 480 x 640 Component 

A10 PAL 576 x 720 Component 

A11 PAL-underscan 576 x 720 Component 

A12 PAL-overscan 576 x 720 Component 

R0 VGA, 640 x 480 480 x 640 DVI/VGA 

R1 SVGA, 800 x 600 600 x 800 DVI/VGA 

R2 XGA, 1024 x 768 768 x 1024 DVI/VGA 

R3 WXGA, 1280 x 768 768 x 1280 DVI/VGA 

R4 WXGA, 1360 x 768 768 x 1360 DVI/VGA 

R5 SXGA, 1280 x 960 960 x 1280 DVI/VGA 

R6 SXGA, 1280 x 1024 1024 x 1280 DVI/VGA 

R7 SXGA+, 1400 x 1050 1050 x 1400 DVI/VGA 

R8 UXGA, 1600 x 1200 1200 x 1600 DVI/VGA 

R9 WUXGA, 1920 x 1200, reduced blanking 1200 x 1920 DVI/VGA 

S0 SD 480i60 480 x 720 SDI 

S1 SD 480i50 576 x 720 SDI 

S2 HD 720p60 720 x 1280 SDI 

S3 HD 720p50 720 x 1280 SDI 

S4 HD 1080i60 1080 x 1920 SDI 

S5 HD 1080i50 1080 x 1920 SDI 
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Section 11: Replacement Parts 

11.1 Daktronics Exchange and Repair & Return Programs 
To serve customers’ repair and maintenance needs, Daktronics offers both an exchange 
program and a repair & return program. 

Exchange Program 
Daktronics unique Exchange Program is a quick service for replacing key parts in need of 
repair. If a part requires repair or replacement, Daktronics sends the customer a replacement 
and the customer sends the defective part to Daktronics. This decreases display downtime. 

Before Contacting Daktronics 
Identify these important part numbers: 

Display Serial Number: _____________________________________________________________  
Display Model Number: ____________________________________________________________  
Contract Number: _________________________________________________________________  
Date Installed: _____________________________________________________________________  
Location of Sign (Mile Marker Number): ______________________________________________  
Daktronics Customer ID Number: ____________________________________________________ 
 

To participate in the Exchange Program, follow these steps. 

1. Call Daktronics Customer Service. 

Market Description  Customer Service Number 

Schools (primarty through community/junior 
colleges), religious organizations, municipal 
clubs, and community centers 

877-605-1115 

Universities and professional sporting events, live 
events for auditoriums and arenas  

866-343-6018 

Finicial institutions, petroleum, sign companies, 
gaming and wholesale/retail establishments 

866-343-3122 

Department of Transportation, mass transits, 
airports, and parking facilities 

800-833-3157 
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2. When the new exchange part is received, mail the old part to Daktronics. 
If the replacement part fixes the problem, send in the problem part which is being 
replaced. 

a. Package the old part in the same shipping materials in which the replacement 
part arrived. 

b.  Fill out and attach the enclosed UPS shipping document.  

c. Ship the part to Daktronics.  

3. A charge will be made for the replacement part immediately, unless a qualifying 
service agreement is in place.  
In most circumstances, the replacement part will be invoiced at the time it is shipped.  

4.  If the replacement part does not solve the problem, return the part within 30 working 
days or the full purchase price will be charged.  
If, after the exchange is made the equipment is still defective, please contact Customer 
Service immediately. Daktronics expects immediate return of an exchange part if it does 
not solve the problem. The company also reserves the right to refuse parts that have been 
damaged due to acts of nature or causes other than normal wear and tear.  

Repair & Return Program  
For items not subject to exchange, Daktronics offers a Repair & Return Program. To send a 
part for repair, follow these steps:  

1. Call or fax Daktronics Customer Service:  
Refer to the appropriate market number in the chart listed on the previous page. Fax: 
605-697-4444  

2. Receive a Return Materials Authorization (RMA) number before shipping.  
This expedites repair of the part.  

3.  Package and pad the item carefully to prevent damage during shipment.  
Electronic components, such as printed circuit boards, should be placed in an antistatic 
bag before boxing. Daktronics does not recommend packing peanuts in packaging.  

4. Enclose 
• Contact name  

• Address 

• Phone numbers 

• The RMA number  

• A clear description of symptoms 
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Shipping Address 
Daktronics Customer Service  
PO Box 5128  
331 32nd Ave  
Brookings, SD 57006 

11.2 Daktronics Warranty and Limitation of Liability  

The Daktronics Warranty and Limitation of Liability is located in the Appendix. The 
Warranty is independent of Extended Service agreements and is the authority in matters of 
service, repair, and display operation. 
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Section 12: Acronyms/Nomenclature 

1080i: high-definition signal with 1080 scanning lines and interlaced (“i”) scanning. This contains up 
to six times the detail of conventional TV pictures.  

720p: high-definition signal with 720 active scanning lines and progressive (“p”) scanning. Used in 
digital television broadcasting, it provides three times the detail of conventional TV pictures.  

Active Input architecture: properties of the video processor that allow for displaying multiple 
channels, zoning, blending, and switching.  

Analog: any signal that varies continuously, as opposed to a digital signal, which contains discrete 
levels. A system or device that operates primarily on analog signals.  

Aspect ratio: the ratio of a picture’s width to height. Most video monitors and televisions display a 
4:3 image; however, widescreen displays 16:9.  

BNC: a type of coaxial cable connector, often used for component video inputs.  

Brightness: the overall light level of an image. Brightness measures the difference in range when 
comparing white to dark tones and colors. It is also called black level and black reference.  

Calibar: pocket-size, portable video calibration device that produces 24 test pattern functions.  

Chrominance: the color component of a video signal, abbreviated C. Chrominance is combined with 
the black-and-white signal (luminance) in composite video connections, but kept apart in S-Video 
and component connections. For higher quality, the single chrominance signal can also be divided 
into B-Y and R-Y components in Y/PB/PR component connections, or into the primary colors of Red, 
Green, and Blue for R/G/B component connections.  

Color Space Conversion: a video processor feature that changes NTSC and PAL color values to LED 
color values, ensuring accurate color reproduction.  

Component video connections (Y/PB/PR): the best method for connecting analog video signals. 
Y/PB/PR is ideal for DVD players and compatible satellite receivers. It uses separate connections for 
luminance (Y), blue color difference (PB), and red color difference (PR).  

Component video connections (R/G/B): the best method for connecting analog video signals. R/G/B 
is ideal for HDTV receivers and computer signals. It uses separate connections for Red (R), Green (G), 
and Blue (B).  

Composite (COMP): a video signal in which the luminance (black and white information) and 
chrominance (color information) are combined on the same wire using one of the coding standards: 
NTSC, PAL, SECAM, etc. Picture quality is lost whenever chrominance and luminance are stripped 
apart.  



 

58 Acronyms/Nomenclature 

Contrast: the range of light-to-dark values of an image proportional to the voltage difference between 
the black and white voltage levels of the video signal. The contrast control is an adjustment of video 
gain. Contrast is also called white bar or white reference. 

Daktronics LED video display: Daktronics-trademarked video displays that use RGB LED 
technology to create full-color images. The displays are capable of showing video and animation in 
4.4 trillion colors, depending on display technology.  

DDR (Digital Disc Recorder): a type of recording system that utilizes a high-capacity hard disk to 
record digital audio or digital video.  

DMP 7000: Self-contained hardware/software playback component used in a digital display control 
system.  

DVI (Digital Video Interface): a digital interface standard used to convert analog signals into digital 
signals to accommodate both analog and digital monitors.  

Frames Per Second (fps): a measure of how much information is used to store and display film and 
digital motion video. Each frame is a still image; displaying frames in rapid succession creates the 
illusion of motion. The more frames per second, the smoother the motion appears. The NTSC video 
format, for example, displays 30 interlaced frames per second.  

Gamma correction: a process used with video images to correct brightness and internal micro-
contrast within the image. Changing the value of the gamma affects middle ranges, while leaving the 
full white and full black of the image unaltered.  

Genlock: short for generator locking device; a device that enables a composite video machine, such 
as a TV, to accept two signals simultaneously. A genlock locks one set of signals while it processes the 
second set. This enables a computer to combine graphics with video signals from a second source, 
such as a video camera.  

HD-SDI (High-Definition Serial Digital Interface): a digital video interface used with high-
definition video.  

Hue: the actual color of an object. Hue defines color on the basis of its position in the color spectrum; 
i.e., red, blue, and green.  

Interlaced scanning: the opposite of progressive scanning. Interlaced scanning is the technology 
behind conventional television signal, which shows half of a frame’s scanning lines every 1/60 second. 
First the odd-numbered lines display, then the even-numbered lines.  

IRE (Institute of Radio Engineers): units of measurement that divide the area from the bottom of 
sync to the peak white level into 140 equal units. 140 IRE equals 1 volt, peak-to-peak. The range of 
active video is 100 IRE. Typically, this measurement is only used for NTSC video.  

Key color: a color in a video image replaced by elements of a second image.  
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Luminance: the black-and-white component of a video signal, abbreviated Y. Luminance is combined 
with the color signal (chrominance) in composite video connections, but kept apart in S-Video and 
component connections.  

Noise: random, unwanted interference with signal, resulting in “snow,” random flecks, or specks of 
unwanted color. 

NTSC (National Television Standards Committee): color video signal that uses 525 scan lines with 
30 frames/60 fields per second. All United States broadcasting uses the NTSC standard.  

Overlay: keyed insertion of one image into another. Overlay is used, for example, to superimpose 
computer-generated text on top of a video image. In video, overlay requires synchronized sources for 
proper operation.  

PAL (Phase Alternating Line): A color TV standard developed in Germany that broadcasts 25 
interlaced frames per second (50 half frames per second) at 625 lines of resolution. Brazil uses PAL M, 
which broadcasts 30 fps. PAL is used throughout Europe and China as well as in various African, 
South American and Middle Eastern countries. PAL's color signals are maintained automatically.  

PLUGE (Picture Line-Up Generation Equipment): Used for aligning monitors and other video 
devices. In some versions of color bars, PLUGE is the black set at the bottom of the red bar that 
contains bars that are blacker-than-black, black, and whiter-than-black. Users adjust monitor 
brightness by watching the PLUGE so the whiter-than-black bar is just visible, and both the black and 
blacker-than-black bars are no longer distinct.  

Progressive scanning: the opposite of interlaced scanning. Progressive scanning shows each scanning 
line in sequence for a more seamless, film-like image.  

Saturation: the color intensity of an image. An image high in saturation appears very bright. An 
image low in saturation appears duller and more neutral. A 100-percent saturated color does not 
contain any white; adding white reduces saturation. An image without any saturation is also referred 
to as a grayscale image.  

SDI (Serial Digital Interface): a digital video interface used with broadcast-grade video.  

SECAM (Système Electronique Couleur Avec Memoire): A color TV standard from France that 
broadcasts 25 interlaced frames per second (50 half frames per second) at 625 lines of resolution, 576 
of which are the visual frame. Used in France and Russia and other countries in Africa, Eastern 
Europe and the Middle East, several countries have switched from SECAM to PAL, and production 
equipment for SECAM is no longer made. Today, almost all work is done in component video 
systems that support 576 scanning lines (SECAM and PAL) or composite video (PAL) and converted 
to SECAM for transmission.  

SMPTE (Society of Motion Picture & Television Engineers) Bars: a multi-purpose test pattern used 
as an adjustment reference and a verification of correct video display operation.  
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S-Video (Super-Video, Y/C Video): a technology for transmitting video signals over a cable by 
dividing the video information into two separate signals: one for color (chrominance), and the other 
for brightness (luminance). When sent to a television, S-Video produces sharper images than 
composite video, where the video information is transmitted as a single signal over one wire; this is 
because televisions are designed to display separate Luminance (Y) and Chrominance (C) signals.  

SXGA (Super eXtended Graphics Array): a standard monitor resolution of 1280 × 1024 pixels. 

Sync: the portion of an encoded video signal that occurs during blanking and synchronizes the 
operation of cameras, monitors, and other equipment. Horizontal sync occurs within the blanking 
period in each horizontal scanning line, and vertical sync occurs within the vertical blanking period. 

Tera Term®: a computer program that obtains diagnostic information through a COM port. Tera 
Term® allows users to see the communication between the computer and the VIP 4500.  

Time constant: sensitivity level to changes in incoming horizontal frequency. VTR is less sensitive 
than TV.  

True PixelSM processing: video processing technology that improves image clarity and color.  

Vectorscope: a vector display unit that allows visual checking of the phase and amplitude of the color 
components of a video signal.  

Venus 7000 controller: Daktronics-designed software that controls displays.  

VGA (Video Graphics Array): a graphics display system for PCs developed by IBM. VGA uses 
analog signals rather than digital signals. VGA computer monitors have a resolution of at least 640 x 
480 pixels.  

Viewable Area (VA): the video area a sign displays. The VA is smaller than the total video signal 
area because a black (or blank) border of about 50 to 100 extra pixels is built into the signal.  

VMax signal: the proprietary signal used with Daktronics displays.  

VIP 4500: acts as an interface between the Venus 7000 controller, the video equipment, and the 
Daktronics LED video display, enabling the complete video signal to appear on a display. The 
processor also provides aspect ratio versatility, allowing either a 16:9 (widescreen) or a 4:3 (standard) 
format.  

Waveform monitor (WFM): a vectorscope that examines the waveform of a video signal and the 
synchronizing pulses.  

XGA (eXtended Graphics Array): a proprietary video card developed by IBM that produces a 
resolution of 1024 x 768 pixels.  

Y, Cr, Cb: color difference signal designation used for various purposes, such as the CCIR/SMPTE 
standard digital component video signal set (CCIR601, RP-125). Y corresponds to luminance, Cr 
corresponds to the R-Y signal and Cb corresponds to the B-Y signal 
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Z-Order: the ordering of overlapping two-dimensional objects on a screen or display; determines 
which object will appear atop the other 
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Appendix:       Daktronics Warranty and Limitation 
of Liability 

Refer to SL-02374 for a complete Warranty and Limitation of Liability.  
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